Problem:

A pin in a knuckle joint carrying a tensile load $F$ deflects somewhat because of the loading resulting in the distribution of reaction and load shown in part $b$ of the figure. The usual designer’s assumption of loading is shown in part $c$; others sometimes choose the loading shown in part $d$. If $a = 0.5$ in, $b = 0.75$ in, $d = 0.5$ in, and $F = 1000$ lb, estimate the maximum bending stress using the loading assumption shown in part $c$. 

Anticipated time to complete this tutorial: 1 hour

Tutorial Overview
This tutorial is divided into six parts:
1) Tutorial Basics
2) Starting Ansys
3) Preprocessing
4) Solution
5) Post-Processing
6) Hand Calculations

Audience
This tutorial assumes minimal knowledge of ANSYS 8.0; therefore, it goes into moderate detail to explain each step. More advanced ANSYS 8.0 users should be able to complete this tutorial fairly quickly.

Prerequisites
1) ANSYS 8.0 in house “Structural Tutorial”

Objectives
1) Model the pin in ANSYS 8.0
2) Analyze the pin for maximum bending stress using ANSYS 8.0

Outcomes
1) Learn how to start ANSYS 8.0
2) Gain familiarity with the graphical user interface (GUI)
3) Learn how to create and mesh a simple geometry
4) Learn how to apply boundary constraints and solve problems
In this tutorial:
- Instructions appear on the left.
- Visual aids corresponding to the text appear on the right.
- All commands on the toolbars are labeled. However, only operations applicable to the tutorial are explained.

The instructions should be used as follows:

- **Bold** Text in bold are buttons, options, or selections that the user needs to click on

Example: > Preprocessor > Element Type > Add/Edit/DeleteFile would mean to follow the options as shown to the right to get you to the Element Types window

- **Italics** Text in italics are hints and notes

- **MB1** Click on the left mouse button
- **MB2** Click on the middle mouse button
- **MB3** Click on the right mouse button

Some basic ANSYS functions are:

To **rotate** the models use Ctrl and MB3.

To **zoom** use Ctrl and MB2 and move the mouse up and down.

To **translate** the models use Ctrl and MB1.
For this tutorial the windows version of ANSYS 8.0 will be demonstrated. The path below is one example of how to access ANSYS; however, this path will not be the same on all computers.

For Windows XP start ANSYS by either using:
   > Start > All Programs > ANSYS 8.0
   > ANSYS
   or the desktop icon (right) if present.

Note: The path to start ANSYS 8.0 may be different for each computer. Check with your local network manager to find out how to start ANSYS 8.0.
Once ANSYS 8.0 is loaded, two separate windows appear: the main ANSYS Advanced Utility Window and the ANSYS Output Window.

The ANSYS Advanced Utility Window, also known as the Graphical User Interface (GUI), is the location where all the user interface takes place.

The Output Window documents all actions taken, displays errors, and solver status.
The main utility window can be broken up into three areas. A short explanation of each will be given.

First is the **Utility Toolbar**:

From this toolbar you can use the command line approach to ANSYS and access multiple menus that you can’t get to from the main menu.

*Note: It would be beneficial to take some time and explore these pull down menus and familiarize yourself with them.*

Second is the **ANSYS Main Menu** as shown to the right. This menu is designed to use a top down approach and contains all the steps and options necessary to properly pre-process, solve, and postprocess a model.

Third is the **Graphical Interface window** where all geometry, boundary conditions, and results are displayed.

The tool bar located on the right hand side has all the visual orientation tools that are needed to manipulate your model.
With ANSYS 8.0 open select
> File > Change Jobname
and enter a new job name in the blank field
of the change jobname window.

Enter the problem title for this tutorial.
> OK

In order to know where all the output files
from ANSYS will be placed, the working
directory must be set in order to avoid using
the default folder: C:\Documents and
Settings.
> File > Change Directory > then
select the location that you want
all of the ANSYS files to be saved.

Be sure to change the working directory at
the beginning of every problem.

With the jobname and directory set the
ANSYS database (.db) file can be given a
title. Following the same steps as you did
to change the jobname and the directory,
give the model a title.
To begin the analysis, a preference needs to be set.

> Main Menu > Preferences

Place a check mark next to the Structural box. This determines the type of analysis to be performed in ANSYS.

> Ok

The ANSYS Main Menu should now be opened. Click once on the “+” sign next to Preprocessor.

> Main Menu > Preprocessor

The Preprocessor options currently available are displayed in the expansion of the Main Menu tree as shown to the right.
As mentioned previously, the ANSYS Main Menu is designed in such a way that one should start at the beginning and work towards the bottom of the menu in preparing, solving, and analyzing your model.

Note: This procedure will be shown throughout the tutorial.

Select the “+” next to Element Type or click on Element Type. The extension of the menu is shown to the right.

> Element Type

Select Add/Edit/Delete and the Element type window appears. Select add and the Library of Element Types window appears.

> ADD/EDIT/DELETE > Add

In this window, select the types of elements to be defined and used for this problem.

For this model Pipe16 elements will be used. We will define them as having a solid shaft rather than an inner diameter.

> Pipe > Elast straight16
> OK

In the Element Types window Type 1 Pipe16 should be visible signaling that the element type has been chosen.

Close the Element Types window.

> Close
The properties for the pipe 16 elements need to be chosen. This is done by adding a Real Constant.

> Preprocessor > Real Constants
> Add/Edit/Delete

The **Real Constants window** should appear. Select add to create a new set.

> Add

The **Element Type for Real Constants window** should appear. From this window, select Pipe16 as the element type.

> Type 1 Pipe16
> OK

The **Real Constant Set Number 1, for Pipe16 window** will appear. From this window you can interactively customize the element type.

From the problem statement the outside diameter of the pin should be 0.5 inches. Since the pin is a solid, the thickness of the elements should be equal to the radius of the outside diameter (should be .25 inches).

Enter the values in to the table as shown to the right.

> Ok

Close the window.

> Close
The material properties for the Pipe16 elements now need to be defined.

> Preprocessor > Material Props
> Material Models

The Define Material Models Behavior window should now be open.

This window has many different possibilities for defining the materials for your model. We will use isotropic, linearly, elastic, structural properties.

Select the following from the Material Models Available window:
> Structural > Linear > Elastic
> Isotropic

The window titled Linear Isotropic Properties for Material Number 1 now appears. This window is the entry point for the material properties to be used for the model.

Enter \(30e6\) (30 Mpsi) in for \(EX\) (Young’s Modulus) and 0.3 for \(PRXY\) (Poisson’s Ratio).
> OK

Close the Define Material Model Behavior window.
> Material > Exit
The next step is to define the keypoints (KP’s) where loads and constraints will be applied:

> Preprocessor > Modeling
> Create Keypoints > In Active CS

The Create Keypoints in Active CS window will now appear. Here the KP’s will be given numbers and their respective (XYZ) coordinates.

Enter the KP numbers and coordinates for the pin definition. Select Apply after each KP has been defined.

Note: Be sure to change the keypoint number everytime you click apply to finish adding a keypoint. If you don’t it will just move the last keypoint you entered to the new coordinates you just entered.

KP # 1: X=0, Y=0, Z=0
KP # 2: X=0.25, Y=0, Z=0
KP # 3: X=0.6875, Y=0, Z=0
KP # 4: X=1.0625, Y=0, Z=0
KP # 5: X=1.5, Y=0, Z=0
KP # 6: X=1.75, Y=0, Z=0

Select OK when complete.

In the case that a mistake was made in creating the keypoints, select:

> Preprocessor > Modeling > Delete
> Keypoints

Select the inappropriate KP’s and select Ok.

The created KP’s should look similar to the example to the right except the KP’s could be labeled with the KP numbers.
At times it will be helpful to turn on the key-point numbers.

> PlotCtrls > Numbering > put a checkmark next to keypoint numbers > OK

Other numbers (for lines, areas, etc..) can be turned on in a similar manner.

The next step is to create lines between the KP’s.

> Preprocessor > Modeling
> Create > Lines > Lines
> Straight Lines

The Create Straight Lines window should appear. You will create 5 lines. Create line 1 between the first two keypoints.

For line 1: **MB1 KP1** then **MB1 KP 2**.

The other lines will be created in a similar manner.

For line 2: **MB1 KP2** then **MB1 KP 3**.
For line 3: **MB1 KP3** then **MB1 KP 4**.
For line 4: **MB1 KP4** then **MB1 KP 5**.
For line 5: **MB1 KP5** then **MB1 KP 6**.

Verify that each line only goes between the specified keypoints. When you are done creating the lines click ok in the Create Straight Lines window.

> Ok

If you make a mistake, use the following to delete the lines:

> Preprocessor > Modeling > Delete
> Lines Only
Now that the model has been created, it needs to be meshed. Only meshed models can be run to find a solution. Models are meshed with elements.

First, the element size will be specified.

- **Preprocessor** > **Meshing**
- **Size Cntrl** > **Manual Size**
- **Lines** > **All Lines**

The **Element Sizes on All Selected Lines window** should appear. From this window the number of elements per lines segment can be defined along with the Element edge length.

Since the length of the pin is 1.75 in, approximately 20 elements along the length of the pin will produce reasonable results.

Enter 0.0875 into the **Element edge length** field since 1.75/20=0.0875 in.

- **Ok**

*Note: you could change the element edge length after completing the tutorial to a different value and rerun the solution to see how it affects the results.*

With the mesh parameters complete the lines representing the pin can now be meshed. Select:

- **Preprocessor** > **Meshing** > **Mesh**
- **Lines**

From the **Mesh Lines window** select **Pick All**.

- **Pick all**

This will select all the line segments and mesh them all at the same time.

The meshed line should appear similar as shown to the right.
Knuckle Joint Pin

Solution

We will now move into the solution phase.

Before applying the loads and constraints to the pin, we will select to start a new analysis
   > Solution > Analysis Type
   > NewAnalysis

For type of analysis select Static and select Ok.

The constraints will now be added.

For this problem the two upward acting forces act as simple constraints or reaction forces. The reaction forces can be modeled as constraints in the X and Y direction.

To apply constraints select:
   > Solution > Define Loads > Apply
   > Structural > Displacement
   > On Keypoints

The Apply U, ROT on KP’s window now appears. It will be easier to select the keypoints if the keypoint numbers are turned on as previously explained. However, the current view probably shows just the elements and not the keypoints. The Plot menu can change the way you see your model. You can see both the elements and the keypoints on the screen by selecting:
   > Plot > Multiplots

To see just the keypoints;
   > Plot > Keypoints > Keypoints

Use the plot menu to view your model in way most helpful to completing the step in tutorial.
With the **Apply U, ROT on KP’s window** open select **KP 2** and **KP 5** from the ANSYS graphics window.

> **Apply**

The **Apply U, ROT on KP’s large window** should appear. From this window the degrees of freedom can be specified.

To the right of **DOFs to be constrained** select **UX**, **UY**, **ROTX**, and **ROTY**.

> **Apply**

The constraints now appear at keypoints 2 and 5.

Now select **KP 3** and **KP 4**.

> **Apply**

The **Apply U, ROT on KP’s large window** should reappear.

Unselect **UX**, **UY**, **ROTX**, and **ROTY** by using **MB1** and then select **UZ** and **ROTZ**.

> **Ok**

The final constraints should now be on **KP 3** and **KP 4**.

The constrained model should appear similar to the right.
The loads will now be applied to the pin.

> Solutions > Define Loads > Apply
> Structural > Force/Moment
> On Keypoints

The **Apply F/M on KP’s window** should appear.

Select **KP 3** and **KP 4** in the graphics window.

> Apply

The expanded **Apply F/M on KP’s window** should appear. From this window the direction of the force and magnitude can be specified.

Select **FY** for the Direction of force/moment. Select **Constant Value** for Apply as.

The total force of 1000 lb will be divided equally between the two pins.

Enter **500** in the **Force/moment** value field which will apply a **-500 lb force**.

Verify that all the fields match those of the figure shown to the right.

> Ok

The fully loaded and constrained model should appear similar to the picture shown on the right.
The next step in completion of the tutorial is to solve the current load step that has been created. Select:

> Solution > Solve > Current LS

The **Solve Current Load Step window** will appear. To begin the analysis select **Ok**.

The analysis should begin and when complete a **Note** window should appear that states the analysis is complete.

Close both the **Note** window and `/STATUS Command` window.
Results are viewed by using post processing commands.

From the ANSYS Main Menu select:
> General Postproc > Element Table
> Define Table

The **Element Data Table window** should appear and should be empty. This window shows which types of results will and can be plotted. Select add.
> Add

The **Define Additional Element Table Items window** should appear. From this window the types of results of interest can be selected to be used for analysis.

From the problem statement it says to estimate the maximum bending stress for the loading assumption in part c. To obtain the stress, select Stress from the Item, Comp, Results data item drag down menu. From the drag down menu to the right of the stress selection, select von Mises SEQV.
> Stress > Von Mises SEQV
> Ok

The picture to the right shows the line that should be added to the **Element Data Table**.

With the result type selected the results can be plotted.

Select Close in the **Element Data Table window**.
> Close
To view results:
> General Postproc > Element Table
> Plot Elem Table

The Contour Plot of Element Table Data should appear. From this window the various types or results that could have been previously defined can be accessed.

Select SEQV from to the right of Item to be plotted.

Select No-do not average for the Average at common nodes field.
> Ok

A plot now appears that shows the von Mises stress contour and the deformation also.

In the top left hand corner of the plot the text SMX = 17825 is displayed. This represents the maximum bending stress in the pin and the location is defined on the pin where its says MX.

The text DMX = .345E-03 represents the maximum deflection of the pin. The color contour of the pin is gaged according to the scale at the bottom of the window to reference various points along the pin.

To validate the results from ANSYS, the hand calculations for the pin configuration desired are provided on the next page.
Problem Statement:
A pin in a knuckle joint carrying a tensile load \( F \) deflects somewhat on account of this loading, making the distribution of reaction and load shown. The usual designer’s assumption of loading is shown in part c; others sometimes choose the loading in part d. If \( a = 0.5 \) in, \( b = 0.75 \) in, \( d = 0.5 \) in and \( F = 1000 \) lb, estimate the maximum bending stress.

Following the loading assumption of Part c which we modeled, we will now present the closed form solution.

\[
\sigma = \frac{Mc}{I} \quad \text{Maximum Bending Stress}
\]

\[
I = \frac{\pi d^4}{64}
\]

\[
c = \frac{d}{2}
\]

\[
M = \text{maximum moment}
\]

Solution:
\[
I = \frac{\pi (0.5)^4}{64}
\]

\[
= 0.003067961576 \text{ in}^4
\]

\[
c = 0.5/2
\]

\[
= 0.25 \text{ in}
\]

The maximum moment is found by using shear/moment diagrams.

From Moment diagram \( M = 218.75 \) lb-in.
To solve for maximum bending stress sub values into sigma.

\[
\sigma = \frac{M c}{I}
\]

\[
= (218.75)(0.25)/(0.003067961576)
\]

\[
\sigma = 17,825.353 \text{ psi} \quad \text{Answer}
\]